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Böwe Bell + Howell Scanners

Disclaimer
The instructions and descriptions contained in this document were accurate at the time of publishing. 
However, succeeding products and documents are subject to change without notice. Therefore, 
Bowe Bell + Howell Scanners, L.L.C. assumes no liability for damages incurred directly or indirectly from 
errors, omissions, or discrepancies between the product and this document.

© 2005 Bowe Bell + Howell Scanners, L.L.C. All rights reserved. All material in this publication is 
confidential and is to be used by and distributed to authorized personnel of the purchaser only. All 
intellectual property rights remain the property of Bowe Bell + Howell Scanners, L.L.C. No part of this 
publication may be reproduced, distributed, modified, displayed, transmitted, stored in a retrieval system, 
or translated into any human or computer language, in any form or by any means, electronic, mechanical, 
magnetic, optical, chemical, manual, or otherwise, without the prior written permission of the copyright 
owner, Bowe Bell + Howell Scanners, L.L.C., 760 South Wolf Road, Wheeling, IL 60090-6232, USA.

© Bowe Bell + Howell Scanners, L.L.C.
760 South Wolf Road

Wheeling, IL 60090-6232, USA

The information given in this manual is subject to change without notice. Please go to 
www.bbhscanners.com to download the most current manual.

  Corporate Offices: 1-847-675-7600
Sales: 1-800-SCAN-494

  Technical Support: 1-800-SCAN-495
1-416-760-4499

TTY Line: 1-847-423-3032
Internet: www.bbhscanners.com

Please read this manual for information about the proper installation, operation and 
maintenance of the scanner. Keep this documentation in a safe place for future reference.
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International Offices

In Europe

Centurion House, London Road
Staines
Middlesex TW18 4AX, England
Telephone +44-1784-410-406
Fax +44-1784-410-303
Technical Support +44-1784-410-207

In Asia: China

No. 2 room, 601 Tower W3, Oriental Plaza
No. 1 East Chang An Ave, Dong Cheng Dist.
Beijing, 100738
China (PRC)
Telephone (86) 10 85181839
Fax +86-10-85181839

In Asia: Malaysia

1005 Level 10, Block B, Phileo
Demansara 1
9 Jalan 16/11
Petaling Jaya 46350
Malaysia
Telephone +60-3-7662-3353
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Windows® XP is Microsoft® Windows® XP operating system.

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries.

VirtualReScan®, Kofax® and ImageControls® are registered trademarks of Kofax Image Products.

ISIS® and PixTools® are registered trademarks of Pixel Translations, a division of Captiva Software 
Corporation.

Adobe®, Acrobat® and Reader® are registered trademarks of Adobe Systems Incorporated.

Pentium® is a registered trademark of Intel Corporation.

USB™ is a registered trademark of the USB Implementers Forum.

Trūper™ is a registered trademark of Böwe Bell + Howell Scanners, L.L.C.

All other product names and logos mentioned herein are the property of their respective companies.
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Typographical Conventions
This table describes the typographical conventions used in this manual.

Items Convention

Names of buttons, links, 
menus, check boxes, radio 
buttons, lists, and fields 
found with software 
applications

These items appear in bold typeface.
Examples:

• Click the Next button.
• Click the User Utility icon.

Variable placeholders, 
references to other 
documents, new or special 
terminology, and emphasis

These items appear in italic typeface.
Examples:

• For more information, refer to the Operator Manual.
• In this location, you can deskew (straighten an image) before saving 

the document.

Names of files, directories, 
folders, paths, windows, 
dialog boxes, Web pages, 
URLs, and e-mail 
addresses

These items appear in normal typeface.
Examples:

• Run the setup.exe to start installation software.
• To view our Website, go to www.bbhscanners.com.

References to sections of 
documents and citations of 
messages displayed to 
users

These items will appear in “quotation marks”.
Examples:

• Refer to “Section 1” in this manual.
• If the error message “Please reload paper” occurs...

Key names and hardware 
button names

These items appear in ALL CAPS.
Examples:

• Press the OFF switch to power down the scanner.
• Press the ENTER key and then type...
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1.0 Introduction
This manual provides detailed information, including descriptions and procedures, for using the Trūper 
scanner’s advanced feature set. Along with VRS (VirtualReScan), the Trūper scanner can enhance image 
quality, enable faster scanning processes, and make it possible to customize how your documents are 
scanned.

Note
There are properties available in VCDemo, Quickscan, and Adobe that are not documented in this 
manual. For information on the properties not explained in this manual, refer to your application’s 
user manual.

This guide assumes the following:
• A Trūper scanner is properly installed 
• VRS software is installed
• Either VRS, VRS TWAIN, or VRS ISIS drivers are installed
• You have previous experience using scanners and scanner applications
• You have a moderate to advanced skill level using scanners and scanner applications

Depending on the driver in which you are using, proceed to one of the following sections:
• “2.0 Using VCDemo with the VRS Driver”
• “3.0 Using QuickScan with the ISIS Driver”
• “4.0 Using Adobe Acrobat with the TWAIN Driver”
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2.0 Using VCDemo with the VRS Driver
This section describes how to set parameters for the way in which documents are scanned using 
VirtualReScan with the VRS driver.

This section contains the following topics:
• “2.1 Scanner Properties” on page 11
• “2.2 Advanced Settings” on page 13
• “2.3 More Settings” on page 14
• “2.4 Other Settings” on page 17
• “2.5 Image Filters on the Imaging Menu” on page 22
• “2.6 Image Filters using VRS Adjustment Controls” on page 24

Note
For detailed information on using the functionality described in this section, refer to your application’s 
user manual.

To select the VRS driver:

1. Select Scanner from the Source menu.

2. Click Bowe Bell + Howell 3200 with SVRS from the Select Scan Source drop-down list, and then 
click the OK button.

The scanner resets the flatbed to the “home” position. When the icons on the toolbar become 
active, you are ready to begin.

3. Click the  icon, and proceed to the next section, “2.1 Scanner Properties”.
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2.1 Scanner Properties
The Scanner Properties window allows you to specify how documents are to be scanned. This includes 
setting the resolution, page orientation, color preferences, and whether documents are scanned in simplex 
or duplex mode.

2.1.1 Source
The Source drop-down list is used to select how the document is to be fed into the scanner. If Flatbed is 
selected, documents are scanned from the glass and can only be scanned single-sided. 

If ADF (Automatic Document Feeder) is selected, documents are scanned from the loading tray. When 
ADF and Duplex are selected, both sides of the document are scanned, but the top loaded side is output to 
the PC first followed by the back side.

2.1.2 Destination
This property is not available with BBH scanners.

2.1.3 Resolution (DPI)
This function specifies the resolution DPI (dots per inch) for the main and subdocument scanning 
parameters. The available resolution setting ranges are 100 to 600 dpi. The typical dpi setting is 200 for 
bitonal documents and 150 for color documents. 

When the resolution is increased, the image becomes clearer. However, the image file size increases, PC 
HDD (Hard Disk Drive) free space decreases and additional scanning time increases. For regular high dpi 
scanning, you may consider purchasing a memory upgrade kit to increase the scanning speed.
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2.1.4 Paper Size
Use the Paper Size option to specify the size of the documents to be scanned. Refer to the Trūper 
Operator Manual for a list of page sizes.

2.1.5 Orientation
The Orientation section is used to specify the layout in which the documents scanned are to be displayed 
on the computer screen. Setting the Orientation also determines how the documents are saved. The 
choices are Portrait and Landscape.

2.1.6 Scan Start (secs)
 For information on the Scan Start (secs) property, refer to your application’s user manual.

2.1.7 Color Mode
The Mode drop-down list provides multiple scanning modes. Table 1, "Mode Options and Descriptions" 
lists the available mode options. 

   

2.1.8 Auto Length Detection
When the Auto Length Detection function is selected, the scanner scans the documents in the size that 
corresponds to the documents length. If, for instance, Length Control is not selected when A4 and A5 width 
documents are scanned continuously, the documents with the A5 width will also be scanned in the A4 size 
and the roller will be scanned for the parts corresponding to their bottom halves. Conversely, if Length 
Control is selected and A4 documents and A5 width documents are scanned in the same session, the A4 
documents will be scanned in the A4 size and the A5 width documents will be scanned in the A5 size, and 
no memory is wasted.

2.1.9 Continuous Sheet
For information on the Continuous Sheet property, refer to your application’s user manual.

2.1.10 Manual Start
For information on the Manual Start property, refer to your application’s user manual.

Mode Description

Black & White Bitonal, image is threshold to either black or white 

Color (true color) High quality image, large file size, image is threshold to 24-bit color

Grayscale High quality image, large file size, image is threshold to 256 shades of gray

Table 1: Mode Options and Descriptions
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2.1.11 Sides
This section allows you to choose if your documents are scanned single-sided (one side only) or duplex 
(front and back).

Note
When ADF and Duplex are selected, both sides of the document are scanned, but the top loaded 
side is output to the PC first followed by the back side.

2.2 Advanced Settings
The Advanced Settings window allows you to set the page layout and which edge of the document will be 
fed to the scanner.

To view the Advanced Settings window:

1. Select Advanced Properties from the Source menu.

2. Select Scanner Driver Settings from the Tools menu.

The Advanced Settings window appears.
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2.2.1 Page Layout
The Page Layout section has the same functionality as “2.1.5 Orientation” on page 12. However, setting 
the Page Layout here overrides the Orientation setting on the Scanner Properties window.

2.2.2 Feed
The Feed section allows you to choose which edge of the document is to be fed first in the ADF (Automatic 
Document Feeder); the choices are Portrait (top or bottom) and Landscape (right or left).

2.3  More Settings
The More Settings window allows you to specify feeding features such as detecting double feed errors and 
the intensity in which they are identified, scanning speed and color options.

To view the More Settings window:

1. Select Advanced Properties from the Source menu.

2. Select Scanner Driver Settings from the Tools menu.

3. Click the More button on the Advanced Settings window. 

The More Settings window appears.

2.3.1 Side
Set this property in the Scanner Properties window. For more information on the Sides property, refer to 
“2.1.11 Sides” on page 13.
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2.3.2 Detect Double Feed
This function detects the feeding of more than one sheet at a time. Ultrasonic waves are aimed at the 
document to detect double feed by the level at which the waves pass through the sheets. This function can 
detect double feed even when sheets are superimposed exactly on top of each other, but it may not detect 
properly with some paper thicknesses and when creasing and other factors are present. The default for 
Detect Double Feed is ON.

 If a double feed is detected, you can opt to be notified. The default setting for this function is Stop.

Note
• When important documents are to be scanned, check the number of document sheets against the 

number of scanned image sheets.
• When scanning a document containing paper in different sizes, double feed can be detected when 

this function is selected.

2.3.3 Feeding Speed
There are two settings for the Feeding Speed; Slow and Normal. It is recommended that you select Slow 
when scanning thin paper, badly creased paper, fragile paper, etc. In this mode, documents are fed at 
about one-half of the speed as in the Normal mode. Scanning documents in Slow mode does not affect 
image quality.

Note
• At a resolution above 300 dpi, the paper is fed at the same speed as in the Normal mode, even if 

the Slow mode has been specified.
• This function cannot be used with flatbed scanning.

2.3.4  Single Color Dropout
For information on the Single Color Dropout property, refer to the Trūper Operator Manual.

2.3.5 Multiple Colors Dropout
For information on the Multiple Color Dropout property, refer to the Trūper Operator Manual.
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2.3.6 Manual Feed Mode
Manual Feed mode allows you to choose how documents are fed to the scanner.

Note
Scanning does not stop if the application does not come with a cancel function. However, pressing 
the START/STOP button on the scanner or opening the scanner cover will discontinue scanning.

2.3.7 Time Out
For information on the Time Out property, refer to your application’s user manual.

Property Description

Off Manual Feed mode is not used.

On Documents are fed to the scanner one sheet at a time. Each time a page is 
inserted into the ADF (Automatic Document Feeder), it is automatically 
scanned.

Start Button When documents are placed in the ADF (Automatic Document Feeder), 
press the START/STOP button to begin scanning. Once all documents 
have been scanned, the scanner returns to the wait status. When placing 
another batch of documents in the ADF (Automatic Document Feeder), 
scanning begins again once the START/STOP button is pressed.

Automatic When a stack of documents are placed on the scanner, they are 
automatically scanned. Once scanning is complete, the scanner returns to 
the wait status. When a new stack of documents are placed on the scanner, 
they are automatically scanned.

Table 2: Manual Feed Mode Properties
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2.4 Other Settings
The Other Settings window allows you to enhance scanning by setting the properties for image 
processing, noise reduction, additional feeding features and more.

To view the Other Settings window:

1. Select Advanced Properties from the Source menu.

2. Select Scanner Driver Settings from the Tools menu.

3. Click the More button on the Advanced Settings window. 

4. Click the Other button on the More Settings window. 

The Other Settings window appears.

2.4.1 Side
For information on the Side property, refer to your application’s user manual.
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2.4.2 White Level From Paper
This function uses white as the reference for the background colors of documents being scanned. When a 
document with a colored background other than white is scanned, the resulting images contain a lot of 
noise. This is because the texture of the paper is scanned, however, when the White Level From Paper 
function is set to On, the texture is ignored resulting in clear images and text.

The White Level From Paper function detects the color at a position of approximately 3 mm along the top 
edge of the paper. It will not work properly if the colors in other areas of the paper differ from the color at 
this position. Also, when this function is used, the scanned image becomes white for approximately 3 mm  
(up to 10 mm depending on the scanning conditions) from the top edge of the paper. However, if the 
reference plate and flatbed background are set to black, this area will not become white.

Note
• This function cannot be used at the same time as Automatic Crop, Deskew, or Margin.
• This function cannot be used in the Color mode.

2.4.3 Automatic Separation
This function enables the scanner to automatically differentiate between text areas and photo areas, and 
scan them accordingly. Text areas are scanned in the Binary mode whereas photo areas are scanned 
using the Dither (halftone) pattern specified in “3.1.3.1 Custom Dither (Halftone) Patterns” on page 28.

Note
• With some documents, it may not be possible to separate the text and photos completely. 

However, when continuously scanning documents whose photo areas are positioned in the same 
places, better results can be obtained by using the Sub Area function. Refer to “3.5 Sub Area” on 
page 36 for more information.

• The Automatic Separation function is valid only in the Black & White mode. It cannot be used at 
the same time as Noise Reduction, Sub Area, Dynamic Threshold, Automatic Crop or Deskew.

2.4.4 Binary Dynamic Threshold
For information on the Binary Dynamic Threshold property, refer to your application’s user manual.

2.4.5 Color Matching
For information on the Color Matching property, refer to your application’s user manual.

2.4.6 Dither (Q)
For information on the Dither property, refer to your application’s user manual.
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2.4.7 Gamma
This function selects the gamma curve (shading adjustment curve). The settings available for the gamma 
curve are Normal, For CRT, User Download and Linear, which are described in detail in Table 3, "Gamma 
Settings".  Gamma can be set in Color mode, Grayscale mode, or Black & White mode.

Note
The Gamma function cannot be used when sRGB or ICM have been selected by Color Matching.

To set the gamma pattern:

1. Select the target gamma curve from the Gamma drop-down list. 

To create custom gamma patternsfiles, refer to “2.4.7.1 Creating Gamma Pattern Files” on page 20.

2. Click the Download button and select the gamma pattern file (*.PXG).

3. Select the pattern files by clicking the Binary/Gray, Red, Blue or Green button. In the case of color, 
the pattern files must be set for Red, Blue and Green.

Normal This is the most common setting used when scanning business 
documents. 

For CRT This is the recommended setting if the primary objective of scanning 
documents is to view them on the display. It is most common when 
scanning photos or images.

User Download This setting is used when you want to use a gamma pattern file that 
you have created. For information on generating your own gamma 
pattern files, refer to “2.4.7.1 Creating Gamma Pattern Files” on 
page 20.

Linear This is the mode that gamma correction is not used.

Table 3: Gamma Settings
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2.4.7.1 Creating Gamma Pattern Files

You can create custom gamma pattern files using a text editor (such as Windows Notepad) or by editing 
the invert.pxg file located in the application directory.

Note
If you edit the invert.pxg file, use Save As, type in a name for the file, and make sure the file 
extension is .PXG. 

2.4.8 Image Processing
For information on Image Processing, refer to the VRS User’s Manual.

2.4.9 Noise Reduction
For information on Noise Reduction, refer to the VRS User’s Manual.

2.4.10 Detect Control Sheet
For information on the Detect Control Sheet property, refer to the VRS User’s Manual.

2.4.11 Skip Control Sheet
For information on the Skip Control Sheet property, refer to the VRS User’s Manual.

2.4.12 JPEG Quality
For information on the JPEG Quality property, refer to the VRS User’s Manual.

2.4.13 Image Features
For information on the Image Features properties, refer to the VRS User’s Manual.

Line 1 Name; the scanner ignores this line

Line 2 Table size; input “256”

Line 3 Input the conversion value of level 0 (brightest level)

Line 4 Input the conversion value of level 1

Line 258 Input the conversion value of level 255 (darkest level) 

For the data to be set, “0” is the brightest settings and “255” is the 
darkest setting.
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2.4.14 Chroma

For information on the Chroma property, refer to your application’s user manual.

2.4.15 Length Control (paper length control)
When the Length Control function is selected, the scanner scans the documents in the size that 
corresponds to the documents length. If, for instance, Length Control is not selected when A4 and A5 width 
documents are scanned continuously, the documents with the A5 width will also be scanned in the A4 size 
and the roller will be scanned for the parts corresponding to their bottom halves. Conversely, if Length 
Control is selected and A4 documents and A5 width documents are scanned in the same session, the A4 
documents will be scanned in the A4 size and the A5 width documents will be scanned in the A5 size, and 
no memory is wasted.

Note
The Length Control function has the same functionality as the Auto Length Detection function. 
However, setting the Length Control function here overrides the Auto Length Detection function 
previously set.

2.4.16 Detect Paper Width
When Detect Paper Width is used, the Size and Page Layout specified in Page Size settings are ignored, 
and the scanner sets the page size as determined by the paper guide position.

2.4.17 Skew Stop
This function stops scanning when the paper fed by the ADF (Automatic Document Feeder) is significantly 
skewed. When Skew Stop has been activated, open the scanner door and remove the paper remaining 
inside. Then compare the document against the scanned data, and reinsert the paper up to the appropriate 
page. Scanning may not have been completed for some pages of the document remaining inside the 
scanner.

Note
The Skew Stop function does not work if the paper width is less than 148 mm.

2.4.18 Long Paper (X)
For information on the Long Paper (X) property, refer to your application’s user manual.
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2.5 Image Filters on the Imaging Menu
In order to use the advanced image filters for scanning, you must have VRS 4.00.101 (OEM version). The 
image filters listed on the Imaging menu allow you to utilize functionality such as bar coding, deskewing, 
border removal, patchcode properties and so on.

Note
Some of the properties listed on the Image menu are not described in this manual. For information 
about those properties, refer to your application’s user manual or the VRS User’s Manual.

To enable the Imaging menu:

1. Select Scanner from the Source menu.

2. Click Bowe Bell + Howell 3200 with AIPE from the Select Scan Source drop-down list, and then 
click the OK button.

The scanner resets the flatbed to the “home” position. When the icons on the toolbar become 
active, you are ready to begin.

3. Select the desired property from the Imaging menu.

2.5.1 Barcode Detection
This image filter recognizes the barcodes in the scanned images. Refer to the scanning application’s 
operating manual how to use the barcode. If the barcodes cannot be recognized properly, the quality of the 
scanned images can be improved by using another image filter, examples of which are given in 
Table 4, "Example of Filters and Descriptions".

Filter Description

Deskew Straightens out the image skew

Noise Removal Reduces the image noise

Line Removal Restores the barcode lines

Smoothing Smooths out the barcode lines

Table 4: Example of Filters and Descriptions
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In order to obtain the ideal image quality and speed for barcode detection, it is recommended that the 
settings of the image filters be adjusted while scanning a test document.

2.5.2 Deskew
This function corrects the skew in scanned images by restoring the images to the upright position. 
Deskewed images (text or graphics) may appear serrated. To correct this, select the Smooth check box.

Note
If there is any foreign matter on the reference plate or flatbed sheet when documents are scanned, 
dark areas may appear around the document edges. If this happens, clean the reference plate or 
flatbed sheet.

2.5.3 Patchcode Detection
For information on the Patchcode Detection property, refer to your application’s user manual or the VRS 
User’s Manual.

2.5.4 Image Scaling
For information on the Image Scaling property, refer to your application’s user manual or the VRS User’s 
Manual.

Property Description

Types section If the barcode type is known ahead of time, clear the check boxes at the 
sides of the barcode types which will not be used. The fewer barcodes 
selected, the faster the processing.

Patch Code The data does not appear as ASCII character strings with some barcode 
types such as Code128. Special characters are used for Code39 and other 
barcode types. When the Decode Symbol option is selected, the data of 
these barcodes is changed into readable ASCII character strings.

Note: It is recommended that Decode be enabled unless it is clear that the 
barcode detection results must not be converted into ASCII character 
strings.

Limits Set to string length if the length of the barcode character string is known 
ahead of time. The recognition accuracy and speed can be improved by 
specifying this length.

Search Directory This is specified if the position of the barcode to be detected is known 
ahead of time. The recognition accuracy and speed can be improved by 
specifying the barcode position.

Table 5: Barcode Properties
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2.5.5 Line Removal
For information on the Line Removal property, refer to your application’s user manual or the VRS User’s 
Manual.

2.6 Image Filters using VRS Adjustment Controls
The image filters in the VRS Adjustment Controls window allow you to utilize functionality such as Auto 
Orientation, Noise Reduction, and so on. Using these features enhances the output of your scanned 
document.

To view the VRS Adjustment Controls:

1. Select Scanner from the Source menu. 

2. Click Bowe Bell + Howell 3200 with AIPE from the Select Scan 
Source drop-down list, and then click the OK button.

The scanner resets the flatbed to the “home” position. When the icons 
on the toolbar become active, you are ready to begin.

3. Select Advanced Properties from the Source menu.

4. Select Scanner Driver Settings from the Tools menu.

The VRS Adjustment Control window appears.

2.6.1 Brightness and Contrast
The Brightness function adjusts the image brightness. There are 3 preset modes - Darken, Normal and 
Lighten. When the brightness is set to be darkened, light colored characters and objects are easier to see. 
Alternately, when the slide is selected to be lightened, fine dots or noise are eliminated. A balance between 
eliminating the unwanted dots and document quality can be manually set. The range is between 1 and 255 
with a default setting of 128. 

Note
There are independent back and front side settings for the brightness.
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2.6.2 Invert Image
For information on the Invert Image property, refer to your application’s user manual or the VRS User’s 
Manual.

2.6.3 Noise Removal
This image filter reduces the noise (black spots) of images. Noise is caused by particles of carbon 
deposited from the printing by the copier or fax machine and by dirt and other foreign matter on the 
documents when they are scanned. 

When noise is removed from the text areas, the dots over the letters “i” and “j” and other information may 
also be removed in error. To correct this, select a value larger than the gap between the dots and other 
parts for the minimum gap setting. 

Note
When the Noise Removal and Crop functions are applied to the same image, better results are 
yielded when Noise Removal is applied first. In order to obtain the optimum image quality and speed, 
it is recommended that the settings of the image filters be adjusted while scanning an actual 
document. Depending on the images being scanned, this filter may not function properly.
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3.0 Using QuickScan with the ISIS Driver
This section contains the standard procedures for setting the parameters for the way in which documents 
are scanned using QuickScan Pro with the ISIS driver. 

This section contains the following topics:
• “3.1 Preview Settings” on page 27
• “3.2 More Settings” on page 31
• “3.3 Other Settings” on page 33
• “3.4 Scan Area” on page 34
• “3.5 Sub Area” on page 36
• “3.6 Image Filters” on page 37

Note
For detailed information on using the functionality described in this section, refer to your application’s 
user manual.

To select the ISIS driver:

1. Select Select Scanner from the Scan menu.

2. Click Bowe Bell + Howell 3200 from the Select Scan Source drop-down list, click the OK button, 
and then proceed to “3.1 Preview Settings” on page 27.
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3.1 Preview Settings
The Preview Settings window is where you can configure your scanning preferences. You can specify if 
you want to scan in color or black and white, image quality, page layout and more.

To view the Preview Settings window:

1. Select Preview Settings from the Scan menu.

The Preview Settings window appears.

3.1.1 Mode
The Mode drop-down list provides multiple scanning modes. Table 6, "Mode Options and Descriptions" 
lists the available mode options and their descriptions. 

Mode Description

Black and White Bitonal, image is threshold to either black or white 

256-Level Gray High quality image, large file size, image is threshold to 256 shades of gray

24-bit Color High quality image, large file size, image is threshold to 24-bit color

Binary&Color Image output is dual bitonal and 24-bit color

Binary&Gray Image output is dual bitonal and 256 shades of gray

Table 6: Mode Options and Descriptions
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3.1.2 Dots per inch
This function specifies the resolution DPI (dots per inch) for the main and subdocument scanning 
parameters. The available resolution setting ranges are 100 to 600 dpi. The typical dpi setting is 200 for 
bitonal documents and 150 for color documents. 

When the resolution is increased, the image becomes clearer. However, the image file size increases, PC 
HDD (Hard Disk Drive) free space decreases and additional scanning time increases. For regular high dpi 
scanning, you may consider purchasing a memory upgrade kit to increase the scanning speed.

3.1.3 Dither
The Dither mode is primarily used for black and white photographs. It accelerates scanning speed by 
transforming a grayscale image to a black and white image. The first and least apparent adjustment can be 
made with the Error Diffusion filter, then a little more with Bayer Dither 64, then Bayer Dither 16, 45 deg. 
Halftone, and finally, for the most extreme transformation, 0 deg. Halftone.

Note
Error Diffusion cannot be used when Autocrop, Deskew or Dynamic Threshold are selected.

You can also use the User Download option to select a customized dither pattern. For information on 
creating custom dither patterns, refer to the next section, “3.1.3.1 Custom Dither (Halftone) Patterns” on 
page 28.

3.1.3.1 Custom Dither (Halftone) Patterns

Using the ISlS driver, the Halftone (dither) patterns can be customized. This function specifies the DPI 
(dots per inch) for the main and subdocument scanning parameters. The available resolution setting 
ranges are 100 to 600 dpi. The typical dpi setting is 200 for bitonal documents and 150 for color documents
. When the resolution is increased, the image becomes clearer. However, the image file size increases, PC 
HDD (Hard Disk Drive) free space decreases and additional scanning time increases. For regular high dpi 
scanning, you may consider purchasing a memory upgrade kit to increase the scanning speed.

When setting the dpi, you can either select a preset number from the drop-down list or type in the desired 
dpi. 

Note
When using either the Black and White, Binary&Color or Binary&Gray mode, the color or gray image 
resolution can be set to a ratio of 111, 112, 113 or 714 dpi of the black and white resolution. However, 
the color resolution cannot be set outside the 100 to 600 dpi range. See details on the MultiStream 
mode within the ISIS scanning software application or “3.1.1 Mode” on page 27.
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You can create custom dither patterns using Windows Notepad or Wordpad which you can upload to your 
scanning application. The dither pattern should follow the format in Table 7, "Dither (Halftone) Pattern 
Format". Once you have finished creating the file, save it with the file extension .pxh.
.

Note
When setting the slice date, “0” is the brightest setting and “255” is the darkest.

3.1.4 Brightness
The Brightness function adjusts the image brightness. There are 3 preset modes - Darken, Normal and 
Lighten. When the brightness is set to be darkened, light colored characters and objects are easier to see. 
Alternately, when the slide is selected to be lightened, fine dots or noise are eliminated. A balance between 
eliminating the unwanted dots and document quality can be manually set. The range is between 1 and 255 
with a default setting of 128. 

Note
For details on how to set the scanning brightness automatically in the Black and White mode, refer to 
“2.4.4 Binary Dynamic Threshold” on page 18.

There are independent back and front side settings for the brightness.

3.1.5 Contrast
The Contrast function sets the contrast between black and white images. When using a Dither (Halftone) 
pattern or Grayscale or Color mode, the values between dithers and contract are interactive. The values 
from 1 to 255 can be set, the default setting being 128. The lower the contrast setting, the more delicate in 
texture or grain the image will be. Conversely, the higher the contrast value, the sharper the image will be.

Note
Like the brightness manual setting, the contrast can be independently set for the front and back 
sides of the document.

Line Number Description

1 Name - Do not use

2 Table size - input 8x8

3 Input 8 slice levels of the first column with the spaces between them

4 Input 8 slice levels of the second column with the spaces between them

10 Input 8 slice levels of the eighth column with the spaces between them

Table 7: Dither (Halftone) Pattern Format
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3.1.6 Side
This section allows you to choose if your documents are scanned single-sided (one side only) or duplex 
(front and back).

Note
When ADF and Duplex are selected, both sides of the document are scanned, but the top loaded 
side is output to the PC first followed by the back side.

3.1.7 Page Size
Use the Page Size option to specify the size of the documents to be scanned.

Note
Changing the page size initializes the “3.4 Scan Area” and “3.5 Sub Area”. Ensure that the page size 
and feed are set before adjusting the Sub Area.

3.1.8 Page Layout
The Page Layout section is used to specify the layout in which the documents scanned are to be displayed 
on the computer screen. Setting the Page Layout also determines how the documents are saved. The 
choices are Portrait and Landscape.

Note
Changing the page size initializes the Scanning Area and Sub Area. Complete the settings before 
selecting these items. If Automatic Crop or Detect Paper Width has been set, the page size cannot 
be set or the setting becomes invalid. 

3.1.9 Feed
The Feed section allows you to choose which edge of the document is to be fed first in the ADF (Automatic 
Document Feeder); the choices are Portrait (top or bottom) and Landscape (right or left).

3.1.10 Paper Source
The Paper Source function selects the paper side(s) to be scanned. If the scanner flatbed is selected, the 
only option is simplex. Selections include: Auto Select, Flatbed, ADF Simplex or ADF Duplex. 

When using the Auto Select option, the scanner first looks to see if a document is present in the ADF 
(Automatic Document Feeder). If not, then the default is set to the flatbed. Check your scanning application 
to determine if this is available.

When ADF and Duplex are selected, both sides of the document are scanned, but the top loaded side is 
output to the PC first followed by the back side.
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3.2 More Settings
The More Settings window allows you to set how the documents will be fed into the scanner, whether they 
will be scanned in color or grayscale, and if they will be feed manually or automatic. 
 
To view the More Settings window:

1. Select Preview Settings from the Scan menu.

2. Click the More button on the Preview Settings window. 

The More Settings window appears.

3.2.1 Side
For information on the Side property, refer to your application’s user manual.

3.2.2 Detect Double Feed
This function detects the feeding of more than one sheet at a time. Ultrasonic waves are aimed at the 
document to detect double feed by the level at which the waves pass through the sheets. This function can 
detect double feed even when sheets are superimposed exactly on top of each other, but it may not detect 
properly with some paper thicknesses and when creasing and other factors are present. The default for 
Detect Double Feed is ON.

 If a double feed is detected, you can opt to be notified. The default setting for this function is Stop.

Note
• When important documents are to be scanned, check the number of document sheets and the 

number of scanned image sheets.
• When scanning a document containing paper in different sizes, double feed can be detected when 

this function is selected.
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3.2.3 Feeding Speed
There are two settings for the Feeding Speed; Slow and Normal. It is recommended that you select Slow 
when scanning thin paper, badly creased paper, fragile paper, etc. In this mode, documents are fed at 
about one-half of the speed as in the Normal mode. Scanning documents in Slow mode does not affect 
image quality.

Note
• At a resolution above 300 dpi, the paper is fed at the same speed as in the Normal mode, even if 

the Slow mode has been specified.
• This function cannot be used with flatbed scanning.

3.2.4 Single Color Dropout
For information on the Single Color Dropout property, refer to the Trūper Operator Manual.

3.2.5 Multiple Color Dropout
For information on the Single Color Dropout property, refer to the Trūper Operator Manual.

3.2.6 Manual Feed Mode
For information on the Manual Feed Mode property, refer to your application’s user manual.

3.2.7 Time Out
For information on the Time Out property, refer to your application’s user manual.
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3.3  Other Settings
The Other Settings window is used to set the properties for advanced scanning preferences.

To modify the More Settings window:

1. Select Preview Settings from the Scan menu.

2. Click the More button on the Preview Settings window. 

3. Click the Other button on the More Settings window. 

The Other Settings window appears.

Refer to “2.4 Other Settings” on page 17 for detailed information about this window.
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3.4 Scan Area
The Scan Area option allows a selected portion or region to be scanned, rather than the entire document. 
The scanning area is specified by the start position X (horizontal) and Y (vertical) from the top left corner of 
the paper, the image width and the length.

Note
The scanning area function cannot be used at the same time as Automatic Crop, Deskew, Margin, 
Detect Paper Width, Control Sheet or Length Control.

In the case of duplex scanning, only X can be set separately for the front and back.

To access the Scan Area window:

1. Select Preview Settings from the Scan menu.

2. Click the Area button on the Preview Settings window.

The Scan Area window appears.

3.4.1 Select Setting Side
For information on the Select Setting Side property, refer to your application’s user manual.
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3.4.2 Page Size
Use the Page Size option to specify the size of the documents to be scanned.

Note
Changing the page size initializes the “3.4 Scan Area” and “3.5 Sub Area”. Ensure that the Page 
Size and Feed properties are set before adjusting the Sub Area. 

3.4.3 Page Layout
The Page Layout section is used to specify the layout in which the documents scanned are to be displayed 
on the computer screen. Setting the Page Layout also determines how the documents are saved. The 
choices are Portrait and Landscape.

Note
Changing the page size initializes the Scanning Area and Sub Area. Complete the settings before 
selecting these items. If Automatic Crop or Detect Paper Width has been set, the page size cannot 
be set or the setting becomes invalid. 

3.4.4 Feed
The feed section allows you to choose which edge of the document is to be fed first in the ADF (Automatic 
Document Feeder); the choices are Portrait (top or bottom) and Landscape (right or left).

3.4.5 Area
For information on the Area properties, refer to your application’s user manual.
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3.5 Sub Area
The Sub Area function enables separate scanning conditions to be set in one part of the scanning range. 
For example, if there is a region of the document that consistently contains a color graphic, you can 
achieve better scanning results by specifying the whole page in Black and White mode and then specifying 
the photo area as a Halftone.

Note
The Sub Area function can be used only when Image Type is set to the Black and White (Bitonal) 
mode. It cannot be used when Margin, Detect Paper Width, Dynamic Threshold, Automatic 
Separation, Automatic Crop, Deskew or Noise Reduction have been set. (Even if it can be set, the 
setting is ignored.)

Only one type of Halftone (dither) pattern can be configured. Three areas can be specified for each 
scanning side.

To access the Scan Area window:

1. Select Preview Settings from the Scan menu.

2. Click the SubArea(W) button on the Preview Settings window.

The Sub Area window appears.

3.5.1 Side
For information on the Side property, refer to your application’s user manual.
www.bbhscanners.com                                             36 of 48

http://www.bbhscanners.com


3.5.2 Dither
The Dither mode is primarily used for black and white photographs. It accelerates scanning speed by 
choosing one of the five preset dither patterns described in “3.1.3 Dither” on page 28. 

3.5.3 Brightness
For information on the Brightness property, refer to “3.1.4 Brightness” on page 29.

3.5.4 Area
For information on the Area properties, refer to your application’s user manual.

3.6 Image Filters
The following image filters are provided with the ISIS driver. For information about filters not described in 
this manual, refer to your application’s user manual.

Filter Description

Barcode Detection Recognized barcodes

Border Removal Removes the black areas around the images

Crop Removes the white areas around the images

Deskew Corrects the skew

Dilation Makes the characters thicker, etc.

Erosion Makes the characters finer, etc.

Halftone Removal Removes the halftones

Hole Removal Removes the images of punched holes

Image Scaling Enlarges or reduces the image size

Invert Image Converts white into black and vice versa

Line Removal Removes the lines

Noise Removal Reduces the noise

Patchcode Detection Recognizes patchcodes

Rotation Rotates the images in 90-degree increments

Skeleton Turns images into fine lines

Smooth Removes protrusions and indentations from text as well as lines

Table 8: Image Filters and Descriptions
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More than one image filter can be set at a time. However, as additional filters are added, the scanning 
speed may decrease.

Note
Image filters can be used only in the Black and White mode.

To add image filters in QuickScan:

1. Click New Batch on the Scan menu. 

The New Batch window appears.

2. Select a profile from the list and then click the Add button. Depending on the option you choose, 
some filters may or may not be available.

3. Click the Image Processing tab in the Profile Editor window.

4. Select the Image processing during scan check box if it is not already selected.

5. Select the desired image filter from the Available Filters list box, and then click the Add button.

The image filter is added to the Selected Filters list box.

6. If the Configure button is enabled, click it to adjust the filter’s settings.

For more detailed information on the available filters, refer to the Image Filter help or the 
application’s user manual.

To remove image filters in QuickScan:

1. Click New Batch on the Scan menu. 

The New Batch window appears.

2. Select a profile from the list and then click the Add button.

3. Click the Image Processing tab in the Profile Editor window.

4. Select the desired image filter from the Selected Filters list box, and then click the Remove button.

The image filter is removed from the Selected Filters list box.

Note
If you would do not want to apply any filters, clear the Image processing during scan check box, 
and then click the OK button.

To modify the sequence in which the filters are to be applied:

1. Click the desired filter from the Selected Filters list box and use the  and  to position the 
filter appropriately.

2. When finished, click the OK button.
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3.6.1 Barcode Detection
This image filter recognizes the barcodes in the scanned images. Refer to the scanning application’s 
operating manual how to use the barcode. If the barcodes cannot be recognized properly, the quality of the 
scanned images can be improved by using another image filter, examples of which are given in Table 9, 
"Example of Image Filters with Descriptions".

In order to obtain the ideal image quality and speed for barcode detection, it is recommended that the 
settings of the image filters be adjusted while scanning a test document.

 
 

Property Description

Deskew Straightens out the image skew

Noise Removal Reduces the image noise

Line Removal Restores the barcode lines

Smooth Smooths out the barcode lines

Table 9: Example of Image Filters with Descriptions

Barcode Property Description

Symbologies to 
check

If the barcode type is known ahead of time, clear the check boxes at the 
sides of the barcode types which will not be used. The fewer barcodes 
selected, the faster the processing.

Orientation When Horizontal or Vertical is selected, barcodes inclined less than 15 
degrees from the horizontal or vertical are detected. Use Diagonal to 
recognize barcodes inclined at a greater angle. Vertical barcodes are 
detected slightly more slowly. Recognizing inclined barcodes adds 
additional processing time. If the barcode orientation is known ahead of 
time, the processing speed is improved by selecting only the required 
orientation. Conversely, if the barcode orientation is not known, all the 
orientations must be selected.

Decode Symbol The data does not appear as ASCII character strings with some barcode 
types such as Code128. Special characters are used for Code39 and other 
barcode types. When the Decode Symbol check box is selected, the data 
of these barcodes is changed into readable ASCII character strings.

Note: It is recommended that Decode be enabled unless it is clear that the 
barcode detection results must not be converted into ASCII character 
strings.

Table 10: Barcode Properties and Descriptions
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3.6.2 Crop
This image filter removes the white margins around images. The dimensions of the white margins to 
remain at the top, bottom, left and right can be set separately. Furthermore, by selecting the Force 
Symmetry check box, the same dimensions can be left at the top, bottom, left and right.

Note
The Cropping image filter does not work properly when there is black noise in the margins of the 
images. To correct this, specify the Noise Removal image filter before specifying the cropping image 
filter (refer to “3.6.9 Noise Removal” on page 43).

3.6.3 Dilation
This image filter enlarges the black areas. When it is used, the image quality and legibility of the text are 
improved.

Property Description

Number of 
passes

Input the number of times the Dilate image filter is to be applied. When this number is 
increased, the text and patterns appear thicker. Normally, a setting of “1” is sufficient.

Diagonal The four pixels on the diagonals around the black pixel in the center are replaced with 
black.

Horizontal The two pixels at the left and right of the black pixel in the center are replaced with 
black.

Vertical The two pixels at the top and bottom of the black pixel in the center are replaced with 
black.

Table 11: Dilation Properties and Descriptions
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3.6.4 Erosion
This image filter makes the black areas smaller. When it is used, some information of the image’s detailed 
areas is lost.

3.6.5 Halftone Removal
This image filter removes the background and shading of images.

Note
Depending on the images to be scanned, the Halftone Removal function may not work properly.

3.6.6 Hole Removal
This image filter searches for and removes the images of punched holes or any patterns that resemble 
punched holes from one edge of the images.

• Set the reference plate and flatbed sheet to black when using the Hole Removal function (refer to 
the Trūper Operator Manual for information on changing the background color reference plates.

Note
• Punched holes are not removed unless they are neatly round.
• If text is superimposed on the punched holes, the holes are not removed.
• Depending on the images to be scanned, the Hole Removal function may not work properly.

3.6.7 Invert Image
This image filter converts the white pixels into black pixels and vice versa.

Property Description

Number of 
passes

Input the number of times the Erode image filter is to be applied. When this number is 
increased, the text and patterns appear finer. Normally a setting of “1” is sufficient.

Diagonal The four pixels on the diagonals around the white pixel in the center are replaced with 
white.

Horizontal The two pixels at the left and right of the white pixel in the center are replaced with 
white.

Vertical The two pixels at the top and bottom of the white pixel in the center are replaced with 
white.

Table 12: Erosion Properties and Descriptions
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3.6.8 Line Removal
This image filter reconstructs or removes the ruled lines on images. This function can be used to improve 
OCR results.

Property Sub-property Description

Mode

Remove lines The lines are detected and removed.

Repair First, the lines are detected and removed. Next, the text and/or 
patterns superimposed on the removed lines are restored.

Reconstruct First, the lines are detected and removed. Next, the text and/or 
patterns superimposed on the removed lines are restored. Lastly, 
straight lines are then redrawn at the same locations as the 
removed lines.

Remove Form First, the lines are detected and removed. Next, straight lines are 
redrawn at the same locations. Lines which are considered to be 
parts of ruled lines are joined to each other.

Horizontal/
Vertical

Enable This setting enables the processing of the horizontal and vertical 
lines.

Straight line 
algorithm

This setting is for detecting straight lines. When used, the ability to 
detect straight lines is improved. When this check box is selected, 
the minimum length, maximum gap and curvature settings are 
ignored.

Min Length The minimum length to be detected is specified here. Inches, 
millimeters or points can be used as the unit for the setting. Input 
“mm” or “pt” after the number, respectively. A fraction such as 1/2 
can also be specified as the number.

Max Gap The gap between adjacent lines is specified here. Two lines with a 
gap which is less than the one specified in between is treated as 
one line. Inches, millimeters or points can be used as the unit for 
the setting. Input “mm” or ‘pt” after the number, respectively. A 
fraction such as 1/2 can also be specified as the number.

Curvature A curvature to be treated as a straight line is specified here.

Note: Depending on the images to be scanned, the Line Removal 
function may not work properly.

Table 13: Line Removal Properties and Descriptions
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3.6.9 Noise Removal
This image filter reduces the noise (black spots) of images. Noise is caused by particles of carbon 
deposited from the printing by the copier or fax machine and by dirt and other foreign matter on the 
documents when they are scanned. 

When noise is removed from the text areas, the dots over the letters “i” and “j” and other information may 
also be removed in error. To correct this, select a value larger than the gap between the dots and other 
parts for the minimum gap setting. 

Note
When the Noise Removal and Crop functions are applied to the same image, better results are 
yielded when Noise Removal is applied first. In order to obtain the optimum image quality and speed, 
it is recommended that the settings of the image filters be adjusted while scanning an actual 
document. Depending on the images being scanned, this function may not function properly.

Property Description

Max height The maximum height of what is to be considered as noise is set here. Inches, 
millimeters or points can be used as the unit for the setting. Input “mm” or “pt” 
after the number, respectively. A fraction such as 1/1 00 can also be specified 
as the number.

Max width The maximum width of what is to be considered as noise is set here. Inches, 
millimeters or points can be used as the unit for the setting. Input “mm” or “pt” 
after the number, respectively. A fraction such as 1/1 00 can also be specified 
as the number.

Max area The area which is smaller than a percentage of the area defined by Maximum 
Height and Maximum Width is to be considered as noise. This percentage is 
set here. Normally, a setting of 100 is selected.

Min separation The gap between what is considered as noise and other characters, etc. is set 
here. When the gap is too small, the dots over the letter “i” and other marks are 
considered as noise and removed. Inches, millimeters or points can be used as 
the unit for the setting. Input “mm” or “pt” after the number, respectively. A 
fraction such as 1/4 can also be specified as the number.

Table 14: Noise Removal Properties and Descriptions
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3.6.10 Patchcode Detection
This image filter detects the patchcodes on the images and decodes them. If a patchcode cannot be 
recognized satisfactorily, the quality of the scanning images can be improved by using other image filters. 
For instance, the filters listed below can be used:

Note
In order to obtain the optimum image quality and speed, it is recommended that the settings of the 
image filters be adjusted while scanning an actual document.

3.6.11 Rotation
This image filter rotates the images in 90-degree and 180-degree increments. It can be used to rotate 
images either clockwise or counterclockwise. Mirror processing can also be executed at the same time as 
Rotation.

3.6.12 Scaling
Image Scaling enlarges or reduces the size of the images. When the image width and height are specified, 
the image size is changed accordingly while retaining its original width-to-height ratio. If the width-to-height 
ratio specified differs from the image’s original width-to-height ratio, the image size is changed to the 
maximum size that the width-to-height ratio can be retained within the specified width and height.

Even when the image size is changed using this function, the image’s original width–to–height ratio is 
always retained.

3.6.13 Skeleton
This image filter reduces black areas down to a skeleton, the thickness of a single pixel. When it is used, 
the images become grossly distorted. It is normally used only when so required by OCR (Optical Character 
Reading) or some other application.

Note
When this function is used for photo images, processing takes time increases greatly.

Deskew Straightens out the image skew

Noise Removal Reduces the image noise

Line Removal Restores the patchcode lines

Smooth Smooths out the patchcode lines
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3.6.14 Smoothing
This image filter removes the protrusions and indentations appearing in characters and patterns. When 
five or six surrounding pixels have a different color, this function inverts the pixel concerned. It enables the 
size of files to be reduced when they are compressed with no accompanying loss of image information.

Property Description

Trim First The black pixels are processed before processing the white pixels.

Corner Black The protruding black pixels in the corners are removed.

Corner White The protruding white pixels in the corners are removed.

Note: The pixel processed is the one which is surrounded by five or six 
pixels with the opposite color. Both white and black pixels are processed.

Table 15: Smoothing Properties and Descriptions
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4.0 Using Adobe Acrobat with the
TWAIN Driver

This section contains the standard procedures for setting the parameters for the way in which documents 
are scanned using Adobe Acrobat with the TWAIN driver. 

This section contains the following topics:
• “4.1 Kofax VRS Properties” on page 47
• “4.2 Advanced Properties” on page 48

Note
• For detailed information on using the functionality described in this section, refer to your 

application’s user manual.
• This section is for use with Adobe Acrobat 7.0 Standard.

To select the TWAIN driver:

1. Open Adobe Acrobat.

2. Select Create PDF from the File menu, and then select From Scanner.

The Create PDF from Scanner window appears.

For information on the properties in this window refer to “3.1 Preview Settings” on page 27.

3. Click Kofax Software VRS-TWAIN from the Scanner drop-down list, and then click the Scan 
button. Proceed to the next section “4.1 Kofax VRS Properties” on page 47.
www.bbhscanners.com                                             46 of 48

http://www.bbhscanners.com


4.1 Kofax VRS Properties
The Kofax VRS properties window allows you to specify how documents are to be scanned, the resolution 
in which they are scanned, page orientation, color preferences, and whether the documents are scanned 
in simplex or duplex mode.

4.1.1 Source
The Source drop-down list is used to select how the document is to be scanned. If Flatbed is selected, 
documents are scanned from the glass and can only be scanned Single-sided. 

If ADF (Automatic Document Feeder) is selected, documents are scanned from the loading tray. When 
ADF and Duplex are selected, both sides of the document are scanned, but the top loaded side is output to 
the PC first followed by the back side.

4.1.2 Resolution (DPI)
This function specifies the resolution DPI (dots per inch) for the main and subdocument scanning 
parameters. The available resolution setting ranges are 100 to 600 dpi. The typical dpi setting is 200 for 
bitonal documents and 150 for color documents. 

When the resolution is increased, the image becomes clearer. However, the image file size increases, PC 
HDD (Hard Disk Drive) free space decreases and additional scanning time increases. For regular high dpi 
scanning, you may consider purchasing a memory upgrade kit to increase the scanning speed.

4.1.3 Paper Size
Use the Paper Size option to specify the size of the documents to be scanned. Refer to the Trūper 
Operator Manual for a list of page sizes.
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4.1.4 Color Mode
The Mode drop-down list provides multiple scanning modes. Table 16, "Mode Options and Descriptions",  
lists the available mode options. 

   
For information on the Single-sided property, refer to your application’s user manual.

4.1.5 Orientation
The Orientation section is used to specify the layout in which the documents scanned are to be displayed 
on the computer screen. Setting the Orientation also determines how the documents are saved. The 
choices are Portrait and Landscape.

4.1.6 Simplex/Duplex
For information on the Duplex property, refer to your application’s user manual.

Note
When ADF and Duplex are selected, both sides of the document are scanned, but the top loaded 
side is output to the PC first followed by the back side.

4.2 Advanced Properties
If you have VirtualReScan (VRS) installed on your computer, you can set advanced features such as noise 
reduction, skewing, brightness and so on. 

To view the advanced features with VRS:

1. Open Adobe Acrobat.

2. Select Create PDF from the File menu, and then select From Scanner.

3. Click Kofax Software VRS-TWAIN from the Scanner drop-down list on the Kofax VRS window, 
and then click the Scan button. 

4. Click the Advanced button. 

The VRS VirtualReScan Interactive view opens. For information on the VRS advanced features, 
refer to “2.2 Advanced Settings” on page 13, and “2.6 Image Filters using VRS Adjustment 
Controls” on page 24.

Mode Description

Black/White Bitonal, image is threshold to either black or white 

RGB High quality image, large file size, image is threshold to 24-bit color

Grayscale High quality image, large file size, image is threshold to 256 shades of gray

Table 16: Mode Options and Descriptions
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